Table of Contents

- Overview
- Activating the Policy Management Features
- Creating a Policy Type
- Adding the Policy Assertion Element to the Policy Type
- Creating a Policy
- Adding the Applied Asset Policies Element to a Type
- Applying a Policy to an Asset
- Viewing Policy Status
- Validating Policy Assertions
Overview

- Policies are applied to assets in order to communicate asset requirements that need to be considered during design and development, and to provide administrators with the means to enforce and monitor asset compliance with governance, architecture, and other organizational standards. For example, a policy might articulate corporate quality standards, identifying the platforms that an asset should run on, and identifying acceptable defect density rates.

- A policy can be applied to multiple assets.

- Multiple policies can be applied to any asset.

- Each policy consists of at least one **Assertion Statement**:
  - Each assertion has a name and description, and includes a **Technical Definition**. The Technical Definition accommodates additional metadata that may be required to automatically validate the assertion using third party testing and validation tools. This metadata may be Web service-specific policy information, XML, or any other format that can be read by an external system.
  - For example, an assertion statement for Defect Density might state that defect density must be less than .1%.

Note

Policies will only be available in some configurations using the Advanced Edition of ALER. In addition, the ALER **Compliance Template and Policy Management Data Pack** is required in order to use ALER's Policy Management features. Policies and examples may be obtained by installing the datapack from **CAP**, and then using the **Import/Export Tool** to import them into your environment.
Activating the Policy Management Features

Step 1: Enable the Policy Management System Settings

This procedure is performed on the BEA AquaLogic Enterprise Repository Admin screen.

1. Click System Settings in the left pane.
2. Enter policy in the System Settings Search text box.

The Policy Management group opens.

3. Make sure the Enable Asset Policies property is set to True.
4. Use the radio buttons to make the appropriate selection for the Collapse Policy Assertions property.
   - True sets the default Asset Detail display of assertions to collapsed.
   - False sets the default Asset Detail display of assertions to expanded.
6. When finished, click the Save button.

Policy management features are now activated.
Step 2: Import the Compliance Template and Policy Management Datapack

After configuring the Policy Management system settings, the Advanced Edition policies and examples can be obtained by installing the Compliance Template and Policy Management Datapack from CAP, and then using the Import/Export Tool to import them into your environment.
Creating a Policy Type

A policy type template can be created using any existing asset type or compliance template type as the basis. Note that Policies are only available in certain product configurations. If your configuration does not support Policies, then you will be unable to create a policy type template.

1. Click Edit/Manage Assets on the AquaLogic Enterprise Repository Assets screen to launch the Asset Editor.

2. Open the Actions menu in the Asset Editor.

3. Click Manage Types to launch the Type Manager.

4. Open the File menu and click New.

5. Select a template from the Type for Defaults pull-down in the Create New Type pop-up.

6. Enter a name in the Type Name box.

7. Click OK.

8. Select Policy Type from the Archetype pull-down on Editor tab in the Type Manager.
Adding the Policy Assertion Element to the Policy Type

In order for the new Policy template to function properly the Policy Assertions element must be added. This simple procedure is performed in the Type Manager.

The Policy Assertions element may be added to any tab in the Policy template. The following instructions will add the Policy Assertions element to the Overview tab.

1. Select Overview in the Tabs section of the Type Manager.

Any elements already assigned to the Overview tab will be listed in the Elements section of the Type Manager.
2. Click **Add**.

3. Select **Policy Assertions** from the pull-down in the **Select an Element Type to Add** pop-up.

4. Click **OK**.

5. The **Edit Policy Assertions** pop-up will appear. Enter a name for the Policy Assertion in the **Display Name** text box. (The example below uses "Policy Assertions" as the name for the element.)

6. Click **OK**.

The **Policy Assertions** element now appears in the **Elements** list.
Creating a Policy

A Policy is a very specific type of asset, with a unique relationship to other assets. Policies are created using a Policy Type (see Creating a Policy Type.)

This procedure is performed in the Asset Editor.

1. Open the File menu and click New.
2. In the Create a New Asset pop-up, enter a name for the policy in the Name text box.
3. Enter a version number (optional).
4. Select the appropriate policy type from the Type pull-down.
5. Select the appropriate Initial State from that pull-down.
6. Click OK.

The policy opens in the Asset Editor.
Note the Policy Assertions section on the Overview Tab.

7. Click Add in the Policy Assertions section.

The Edit pop-up opens.

8. Fill in the Name, Description, and Technical Definition sections as appropriate.

Note: Name and Description are human-readable information; Technical Definition should be machine-readable (XML or similar) information that will allow the assertion to be passed to other
9. Click **OK**.

   The new policy assertion is displayed in the **Policy Assertions** section.

10. Repeat the procedure to add additional assertions to the policy.
Adding the Applied Asset Policies Element to a Type

Policies can only be applied to assets of types to which the **Applied Asset Policies** element has been added. For example, if a Corporate Quality Policy is applicable to all services, then the **Applied Asset Policies** element must be added to the Service asset type to allow the policy to be applied.

The procedure for adding the **Applied Asset Policies** element is performed in the **Type Manager** and is nearly identical to the **Adding the Policy Assertion Element to the Policy Type** procedure.

1. Open the selected asset type.
2. In the **Tabs** section, select the tab to which the **Applied Asset Policies** element will be added.
3. In the **Elements** section, click **Add**.
   
   The **Select an Element Type to Add** pop-up opens

4. Select the **Applied Asset Policies** element.

   ![Select an Element Type to Add](image)

5. Click **OK**.

   The **Edit Applied Asset Policies** pop-up opens.

6. Enter an appropriate name in the **Display Name** text box.
7. Click **OK**.

8. The **Applied Asset Policies** element appears bearing its assigned name in the list in the **Elements** section.
Applying a Policy to an Asset

Note: User must be assigned the **Apply Policy** permission in the **Policy Basic Access Setting**.

The procedure for adding a policy to an asset is performed in the asset detail display.

1. Using AquaLogic Enterprise Repository's **Search** or other means, locate the asset to which the policy is to be added.
2. Click the **Apply Policies** button in the asset detail display.
3. Click **List All Policies** to display a list in the **Available Asset Policies** box.
4. Use the >> or All >> buttons to move selected policies to the **Applied Asset Policies** box.
In the example above the **Sample Policy - Corporate Quality Standards** policy has been applied.

5. Click **Save**.

6. A confirmation message is displayed.

![Apply Policies](image)

7. Click **Close**.

8. Refresh the asset detail frame.

9. The presence of the ![icon](image) in the **Overview** section of the asset detail indicates that a policy has been applied. (A smaller version of the same icon indicates policy assignment for assets listed in search results.)

![Overview](image)

Note that **Sample Policy - Corporate Quality Standards** is identified as an applied policy in the **Relationships** section of the asset detail. Click the text link for any listed policy to display its details.
The Relationships section of the policy detail lists the assets to which Sample Policy - Corporate Quality Standards has been applied. Click the link for Sample Service - Account Detail (2.0) to return to the detail display for that asset.

**Note:** Multiple policies may be applied to any eligible asset.
Viewing Policy Status

Policy status is indicated by the specific icon that appears in the asset detail display and in search results. (Policy status is also indicated in the in the optional Navigator.)

Policy status is determined by the asset's compliance with assertion statements within applied policies. If multiple policies are applied, the asset achieves passed status only when in compliance with each applied policy.

Similarly, since a policy can consist of multiple assertion statements, an asset achieves passed status only when in compliance with all assertion statements within all applied policies.

<table>
<thead>
<tr>
<th>Status: <strong>Applied</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that one or more policies have been applied to the asset, and that pass/fail status is indeterminate.</td>
</tr>
<tr>
<td>Any combination of passed and indeterminate assertion statements results in indeterminate asset status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status: <strong>Passed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that the asset is in compliance with every assertion statement within every applied policy.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status: <strong>Failed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that the asset is not in compliance with all assertion statements within all applied policies.</td>
</tr>
<tr>
<td>Failure to comply with any assertion statement within any applied policy results in Failed status.</td>
</tr>
</tbody>
</table>
Validating Policy Assertions

Policy assertions can be validated manually (through the Enterprise Repository) or automatically using testing and validation tools. This document will cover the manual validation of policy assertions. For automatic validation processes, refer to the documentation for your specific testing and validation tools.

Manual validation of policy assertions is performed in the Asset Editor.

1. Locate the asset to be updated.
2. Locate the Applied Asset Policies section within the asset.
   
   The specific label and location of this section will be determined by the configuration of the Policy element within the Type template.
3. Select (single click) the policy to be updated.

![Applied Asset Policies](image)

4. Click Details.
   
   The View Policy pop-up opens.
The asset's compliance status with any policy listed in the View Policy section is indicated in the Result column. In the example above the status unknown indicates that the policy has been applied to the asset but compliance with that policy's assertion statement(s) has not been evaluated.

5. Select (single click) the assertion statement to be updated.

6. Click Edit.

The Edit Assertion Result pop-up opens.
7. Open the **Evaluation Value** pull-down and select the appropriate status.

In this example the **pass** status is selected. Note that additional details can be provided in **Evaluation Information**.

8. Click **OK**.

9. The updated status is displayed in the **Result** column in the **View Policy** pop-up.
10. Continue to validate remaining assertions in the same manner.

11. When finished, click **OK** to close the **View Policy** pop-up.

12. Save the changes to the asset.

13. The ![checkmark](image) icon appears in the asset detail.
It also appears next to the asset's name in search results, indicating policy compliance.